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Foreword

Over the years, Information and Communication Technology (ICT) has greatly impacted 
all aspects of our lives. With the emerging new technologies, the world has become more 
connected and information more digital, greatly influencing the way people learn, live, 
work and communicate. Learning in and for the 21st century requires today’s students to be 
discriminating users of information, creative problem solvers, skilled creators of knowledge, 
and effective communicators.  Literacy with ICT is increasingly becoming an essential skill to 
participate productively in the 21st century knowledge society, in addition to the conventional 
literacy of reading, writing, and numeracy.

The existing ICT curriculum in schools was introduced in 2002 to equip students with 
knowledge and skills relevant for the world of work then. The needs have, however, changed 
over the years but the curriculum has not been able to maintain pace with the change, 
especially in the area of emergent and immersive technologies such as social media.

The development of new ICT curriculum has been in progress since 2014 to address the 
curricular gaps mentioned above. Drawing ideas and inspiration from various international 
educational technology standards and best practices, the ICT Curriculum Framework for 
Classes IV to XII was developed in 2014. Based on the framework, the writing of textbooks 
from classes IV to XII was initiated from 2015.

The approach adopted in the new textbooks is a departure from procedure-oriented teaching 
and learning. The textbooks are designed with emphasis on “competencies” – being able 
to “do” than “know”, thinking critically, being analytical, solving problems and creating 
knowledge by sharing and communicating with each other.

I am hopeful that the new curriculum will pave the way forward in our continuous strive 
to understanding the risks of the digital world as well as its opportunities to achieving the 
promises of technology to transform learning and living.

(Kinga Dakpa)
DIRECTOR

P.O. Box 1243, Shari, Paro–12001, Bhutan     Tel: (Director) +975-8-272561     (PABX) +975-8-
271226/271632/271214

Fax: +975-8-271991         Toll Free: 185          Website: http://www.rec.gov.bt

རྒྱལ་འཛིན་ཤེས་རིག་ཚོགས་སྡེ།
Royal Education Council

Paro : Bhutan
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INTRODUCTION

The present society is characterised by its focus on information its creation, 
dissemination and utilization. It lays emphasis on knowledge to drive 
economy by fostering innovation and entrepreneurship. Information and 
Communications Technology (ICT) plays an important role in making 
the needed information and knowledge easily accessible. ICT has become 
an important enabling tool to create and share information in this 21st 
century society.

Increasingly, children will be exposed to ICT in their daily lives. Education 
also must move forward to bring essential ICT skills to classrooms so that 
children can participate effectively in knowledge society. 

ICT education has moved from ICT literacy to literacy with ICT, from 
“demonstrating ICT skills to choosing, using and sharing ICT, responsibly 
and ethically, to support critical and creative thinking about information 
and about communication across the curriculum” (Literacy with ICT 
Across the Curriculum, 2006). This shift does not belittle the importance 
of ICT literacy. It still is an integral foundation of literacy with ICT.

Literacy with ICT provides our children with the skills and knowledge 
they need to take part in inquiry in knowledge society. Children learn 
to discern information critically, produce knowledge creatively, and 
collaborate with others. Being able to produce information is not enough. 
Using ICT responsibly and safely is a vital attribute of a good ‘digital 
citizen’ in the 21st century. 

Although literacy with ICT will be taught as a separate subject, the 
emphasis is on applying the skills across the curriculum. Where possible, 
attempts have been made to integrate topics from other subjects to provide 
authentic learning to children.
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USING THE TEXTBOOK

Each chapter starts with learning objectives which inform both students 
and teachers of content they are going to deal with. Student activities are 
interspersed for students to link prior knowledge and skills with the new 
content, or to practise new skills. Activities are of two types: Try This on 
Machine, which requires use of computer, and Try This, which can be 
done without the use of computers.

The main learning points covered in a chapter are summed up in Now 
You Know. The Check Your Progress checks for the student’s general 
understanding of knowledge and skills covered. All the excercises under 
this are mostly straight forward. There is another set of student activity 
listed under Explore Further towards the end of the chapter. The exercises 
in this activtiy are designed to extend the knowledge and skills beyond 
what students learned in the chapter. Often, the exercises are set in context 
to the content from other subjects to promote authentic, interdisciplinary 
learning. The idea is to use ICT as an enabling tool to explore learning 
across the curriculum.

Some secondary information related to a given topic are shown in boxes as 
Do You Know?, Caution and Tips to inform students of risks, to advice, 
or to provide useful information. Wherever there is a need to inform the 
teacher of preparation required, a Teacher’s Note callout is provided. 
There is also a section of web links given at the end of each chapter to 
browse for information on the chapter topics. 

Finally, there is End of Year Activity which is similar to Explore Further 
exercise except that this requires students to apply the key skills they 
acquired over the year. Teachers may choose to create their own activity, 
modelled on the sample activity included in the book.
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The book is so designed that it can be covered in one year, with one class 
per week. 

The table given below is an overview of the concepts, skills and values 
covered in each chapter.

Chapter Knowledge Skills Values Weeks

1. Computer
Memory

 - Computer 
memory

 - Storage devices

 - Checking the capacity 
of computer memory 
and storage devices

 - Calculating and 
comparing storage 
capacity

 - Importance 
of memory 
for processing 
information 3

2. More
on MS
PowerPoint

 - Slide master

 - Multimedia in 
presentation

 - Other 
formats of MS 
PowerPoint.

 - Features of 
good MS 
PowerPoint 
presentation

 - Creating slide master.

 - Adding sound and 
video

 - Adding animations.

 - Saving files in other 
formats

 - Advantages 
of making 
a lively 
presentation

 - Importance of 
being creative 3

3. Working
with Audio

 - Audio

 - Audacity 
program

 - SoundCloud

 - Recording audio.

 - Installing and 
uninstalling program

 - Editing audio

 - Exporting audio 
to different audio 
formats

 - Sharing sounds online

 - Creating a project on 
audio 

 - Importance 
of sharing 
creative works

 - Benefits of 
using free 
programs

 - Importance 
of sound in 
everyday life

4
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xi

Chapter Knowledge Skills Values Weeks

4. Malware
Prevention

 - Malware

 - Types of 
Malware

 - Symptoms of an 
infected system.

 - Antivirus

 - Preventing malware 
infection

 - Updating Antivirus.

 - Scanning virus online

 - Importance 
of protecting 
data

 - Benefits of 
updating 
antivirus

 - Awareness 
on malware 
infection

2

5. Valuing
Information

 - Online 
information 

 - Copyright

 - Creative 
Commons

 - Software Piracy

 - Types of 
software piracy. 

 - Verifying online 
information

 - Identifying copyright 
issues

 - Verifying creative 
commons license 

 - Importance 
of verifying 
information

 - Respecting 
others creative 
works

 - Awareness on 
the risk and 
consequences 
of using illegal 
material

2

6. Functions
and
Operators

 - String functions

 - Mathematical 
functions

 - Logical 
operators

 - Using functions and 
operators to create 
programs

 - Importance 
of logical 
thinking and 
reasoning.

 - Exploring 
solutions for a 
situation.

4

7. List and
Custom
Blocks

 - List blocks

 - Custom blocks

 - Creating list.

 - Creating custom 
blocks

 - Using list and custom 
blocks to create 
programs

 - Importance 
of logical 
thinking and 
reasoning

 - Exploring 
possibilities 
to solve a 
problem

4
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COM
PUTER M

EM
ORY

In this Chapter
1.1   Computer Memory
1.2   Types of Memory
1.3   Optical Storage Devices

Learning Objectives
1. Explain different types of computer

memory.
2. Explain storage capacity of computer

memory.
3. Differentiate types of storage devices.

1
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1.1 Computer Memory

Computer memory is a space in a computer where data and 
instructions are stored temporarily or permanently. The smallest unit 
of data that can be stored by a computer is called a bit. A bit is a binary 
digit, it is either 0 or 1. Combination of bits forms bigger storage units. 

A unit of data that is eight bits long is called a byte. A byte is a 
character which can be a text, number or symbol. For example, the 
word ‘success’ has 7 characters and therefore is equivalent to 7 bytes or 
56 bits. Table 1.1 shows the bigger storage units.

Try This

1. How many megabytes are there in 1 terabyte?
2. How many bytes are there in your name?

1.2 Types of Memory

Computer memory is of three types: primary, secondary and cache.

A. Primary Memory
Primary memory refers to the memory of a computer where data and 
instruction are stored for quick access. The following are two types of 
primary memory.

Unit Symbol Bytes
Byte B 1B = 8 bits
Kilobyte KB 1KB = 1024 B
Megabyte MB 1MB = 1024 KB
Gigabyte GB 1GB = 1024 MB
Terabyte TB 1TB = 1024 GB
Petabyte PB 1PB = 1024 TB

Table 1.1. Storage units
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i. Random Access Memory (RAM)

It is temporary memory where the data and instruction that are 
currently in use are kept. Since it is a volatile memory, the contents are 
lost once the computer is turned off. 

When we operate a computer, its operating system, application 
software and files are loaded on to a RAM. It is also called main 
memory or system memory. This is a read and write memory. If 
the capacity of a RAM is bigger, computer works faster. Capacity of 
RAM is generally given in megabytes or gigabytes such as 128 MB, 256 
MB, 1GB and 4GB.

To check the RAM capacity of your computer, right click on Computer 
icon and click on Properties.

Figure 1.1. RAM module of a desktop computer

Figure 1.2. Capacity of RAM
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ii. Read Only Memory (ROM)

It is a memory that stores data permanently.  We can read from ROM 
but cannot write to it. Basic Input/Output System (BIOS) is an example 
of ROM which stores system start up instruction, date and time, and 
information on computer status. It is a non-volatile memory because 
any data stored in ROM remains even if the power is turned off. A 
ROM generally stores several megabytes of data.  

C. Secondary Memory
In this memory, data and instructions are stored for future use. It is 
a non-volatile memory and its contents can be accessed at any time. 
Unlike ROM, data can be written to secondary memory. Hard disk and 
pen-drive are examples of a secondary memory devices.  

D. Cache Memory
Cache memory stores data and instruction that are required frequently. 
Since it is inbuilt in CPU, it can be accessed very quickly. It is faster 
than RAM. Cache memory (Figure 1.4) is also called CPU memory. 
It is also a volatile memory. The capacity of cache memory is very 
small and ranges from few KB to MB. Computer can perform a task 
faster if cache memory is large.

CPU Cache 
Memory

Main 
Memory 
(RAM)

Figure 1.4. Representation of cache memory

Figure 1.3. A BIOS ROM chip
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Try This on Machine

Find out the capacity of your computer’s RAM.

1.3 Storage Devices  

Devices which are used to store data and information are called 
storage devices. They are secondary memory. Storage devices are 
of various capacities. They are either internal or external devices. The 
medium of storage in these devices can be magnetic, optical or solid 
state. 

A. Magnetic Storage
Magnetic storage is a storage of data on a magnetised medium. The 
following are some of the examples.

i. Magnetic Tape

Magnetic tape (Figure 1.5) is a thin plastic tape coated with fine 
magnetic material. It is used to backup and for archiving data such as 
in media house like Bhutan Broadcasting Service and Internet service 
providers like Druknet.  Capacity of magnetic tape varies from 3 MB 
to 185 TB depending on length of the tape. It is durable and cheap. 
However, it takes time to read and write on it.

(a) Video tape

(b) Audio tape

Figure 1.5. Magnetic tapes
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ii. Hard Disk Drive (HDD)

A hard disk drive (Figure 1.6) consists of one or more rotating platter 
made of aluminium or glass coated with magnetic material inside a 
metal case. Usually it is placed inside a computer to store its OS, other 
application software and personal files. It is faster than magnetic tape. 
The capacity of HDD ranges from megabytes to terabytes.  Removable 
hard disk drives are also available to store data. 

To check hard disk capacity of a computer,

1 Click on the My Computer icon on the Desktop to open it.

2 View the capacity of hard disk (capacity of HDD is 465 GB in 
Figure 1.7).

Do You Know?

The Philips Company introduced the first small-cartridge 
cassette tapes and portable tape recorders in the early 
1960s.

(a) Hard disk drive with its protective
cover

(b) Internal parts of hard disk drive

Figure 1.6. Hard disk drive
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Try This on Machine

Write down the hard disk capacity of your computer.

C. Optical  Storage Devices
Optical storage devices (Figure 1.8) are made up of layers of glass or 
plastic. Laser beam is used to write or read data from these devices. 
They are used for archiving data, distributing software, and storing 
multimedia content. There are different types of optical storage devices 
(Table 1.2). They use different technology and have different storage 
capacities.

Figure 1.7. Hard disk capacity

Name Capacity Type
Compact disc (CD) 700 MB i.Pre-recorded (CD ROM)

ii.Recordable Only (CD-R)
iii.Rewritable (CD-RW)

Digital versatile disc

(DVD)

4.7 GB i.Pre-recorded (DVD-ROM)
ii.Recordable only (DVD-R)
iii.Rewritable (DVD-RW)

Blu-ray disc

(BD)

25 GB i.Pre-recorded (BD-ROM)
ii.Recordable (BD-R)
iii.Rewritable (BD-RW)

Table 1.2. Optical storage devices
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D. Solid-State Storage (SSS) Devices
A solid-state storage device uses integrated circuit made of silicon 
microchips to store data. Unlike magnetic and optical storage devices, 
SSS devices do not rotate or move while accessing data. Therefore, they 
are faster. SSS devices have various capacities and different connection 
interfaces (Table 1.3). 

Capacity of storage devices keeps changing due to innovation of new 
technology. SSD can also be used in place of HDD. Replacing internal 
HDD with SSD makes the computer run faster. 

Figure 1.8. Optical storage devices

Device name Capacity Features
Solid-state drive 
(SSD)

Ranges from 
about 128 GB to 
16 TB

 - Durable and costly
 - Can connect through SATA 

(Figure 1.9) or USB.
Memory stick 
or USB drive 
(Figure 1.11)

Ranges from 
about 512 MB to 
256 GB

 - Cheap 
 - Can connect through USB 

Mini or micro 
memory card

Ranges from 8 
MB to 64 GB

 - Cheap
 - Can connect through 

memory card slot or USB 
adapter (Figure 1.10) 

Table 1.3. SSS Devices

ICT Textbook Class 8_2019_CRC.indb   8 7/17/2019   4:50:44 PM



Chapter 1 Computer Memory

9
Reprint 2019

Figure 1.9. Solid-state drive

SATA interface

Adapter

SD cards

Figure 1.11. SD card with adapter

Figure 1. 10. USB drive
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Try This

Fill in the empty boxes in Figure 1.12 with the following words:
Primary,  Memory cards,  RAM,  SSD,  Magnetic tapes,  CD,  
Secondary, ROM.

Figure 1.12. Flow chart

Now You Know

1. Computer memory is the space in a computer or a device to store
data and instructions.

2. Bit is the basic unit of computer data storage.

3. Storage capacities are measured in terms of byte, kilobyte,
megabyte and terabyte.

4. Use of high capacity RAM or cache memory or SSD makes a
computer faster.

5. Computer memory are of three types: primary, secondary and
cache.

Memory
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6. Primary memory stores all the data which are accessed by the
CPU.

7. Secondary memory is a storage device where data is stored
permanently.

8. Cache memory stores data which are used frequently and help
CPU to access data quickly.

9. Data is stored on storage devices using magnetic, optical or solid
state medium.

Check your progress

1. Choose the correct answer.

a. The permanent memory built into your computer is

 • RAM
 • CPU
 • ROM
 • SSD

b. Which one is not a SSS device?

 • Micro memory card
 • CD
 • USB drive
 • Memory stick

c. How many bytes approximately make one megabyte?

 • One thousand
 • Ten thousands
 • One million
 • Ten millions

ICT Textbook Class 8_2019_CRC.indb   11 7/17/2019   4:50:53 PM



Literacy with ICT

12
Reprint 2019

2. Write the difference between the following pairs:

a. RAM and ROM.

b. Magnetic tape and hard disk.

c. Primary and secondary memory.

d. DVD and CD.

3. Write the advantages of SSD over HDD.

4. Sonam has been using a laptop for the last 2 years. Of late, he
has found that it has become slow. Suggest some ways to make
Sonam’s computer work faster.

Explore Further

1. Are there bigger memory units available than petabyte? List all the
units and represent the size of these units in terms of GB.

2. Using the Internet, find out about some storage devices of the
early computer era. Share your findings in the class.

Web Links

1. Computer memory and its types
 K http://www.tutorialspoint.com/computer_fundamentals/computer_

memory.htm
 K http://computer.howstuffworks.com/computer-memory.htm

2. Storage devices and capacities
 K http://explainingcomputers.com/storage.html
 K http://www.igcseict.info/theory/3/
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ERPOINT

In this Chapter
2.1    Slide Master
2.2  Adding Audio and Video
2.3   Animation in MS PowerPoint
2.4   Slide Transition
2.5   Saving in Other Formats

Learning Objectives
1. Create or modify Slide Master.
2. Add sound and videos to presentation
3. Animate a presentation.
4. Save presentation to other file formats.

2

ICT Textbook Class 8_2019_CRC.indb   13 7/17/2019   4:50:54 PM



Literacy with ICT

14
Reprint 2019

Try This

Fill in the blanks with the words given in Table 2.1.
keynote,  presentation,  Presentation software,  slide notes,  
design rules,  slide show

1. A __________ is a way of presenting information to an
audience.

2. Text written below the slides for presenters to refer are
called__________.

3. A __________ allows presenters to combine text, graphics,
audio, video and animations to organize and display
information.

4. One of the popular presentation software used in Apple
computers is ___________.

5. To run a presentation, we need to switch to __________ view.
6. It is always good to follow __________ to make pleasant and

engaging presentation.

We have learnt about creating an interactive and effective presentation 
in Class 7. In this chapter, we are going to learn more MS PowerPoint 
features. Some of the features that will be discussed are Slide Master, 
adding multimedia and applying animation in a presentation.

2.1 Slide Master

Slide Master is an MS PowerPoint feature that applies a uniform design 
to every slide in a presentation. It is a special slide to control how text 
and other multimedia objects appear in the entire presentation.  Using 
Slide Master in a presentation saves time especially when changes in 
design are required in multiple slides. 
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A. Modify Slide Master
1 Click on View tab > Slide Master (Figure 2.1).

 \ Select the top most slide from the Slide Selection Pane. 

 \ Design the slide by adding texts or objects. Any changes made to 
this slide will be applied to all other slides.

 \ You can also change the slide layouts, by making changes to any 
of the slides below the Slide Master. Changes made in each layout 
slide will be applied to all slides using respective slide layouts.

2 Click on Close Master View to get back to normal presentation 
view.

Slide Master Tab

Slide Master 
(applies changes 
to all slides)

Slide layouts 
(applies changes 
to all slide s using 
respective slide 
layouts)

Figure 2.1. Slide Master view
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Try This on Machine

Create the slides given in Figure 2.2. Modify them by applying slide 
master. Save the presentation as TransportSystem.

Figure 2.2. Presentation slides

2.2 Adding Audio and Video

Audio and video are also used to make a presentation interesting. 
Some messages and information are conveyed better using audio and 
video than simply text in a presentation. However, using too much 
sound and video may confuse and distract the audience. 

MS PowerPoint allows you to add and customize audios and videos. 

A. Adding Audio
1 Select a slide where you want to add sound. 

2 Click on Insert > Sound (Figure 2.3).

Transport System
Types of Tranport

Definition

• Movement of people , animal and goods
from one location to another.

• Transportation leads to development
• Types of transportation

-Land Transport
-Air Transport
-Water Transport

Land Transport

• It is the most common form of transport
in Bhutan.

• Horses, mule and yaks are the traditional
means of transport.

• Motorable road started in 1961 in Bhutan

Air Transport

• The first air transport in Bhutan is Druk
Air.

• Druk Air started in 1983
• Air Transport is the fastest mode of
 transport

Water Transport

• Boats and ships.
• Not suitable in Bhutan (landlocked coun 

try).
• Oldest mode of transport. Thank You

1

4 5 6

2 3
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Figure 2.3. Sound option under Insert view

3 Choose an option from the dropdown list as shown in Figure 2.4.

Figure 2.4. Options to insert sound

 • Sound from File: Choose this option if you want to insert
a sound file from your computer. Usually Windows comes
with sample sound files. For instance, in Windows 7, there are
sample music such as Sleep Away, Maid with the Flaxen Hair,
and Kalimba.

 • Sound from Clip Organizer: This option allows you to choose
a sound file that comes with the MS Office Package (Figure
2.5).

Figure 2.5. Sound from clip organizer
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 • Record Sound : In this option, you can record a sound. Click
the record button to record a sound (Figure 2.6); Click the stop
button and click OK. The recorded sound will be automatically
inserted in the selected slide. You will need a microphone
to record a sound and a speaker to play back the sound on
desktop computers. Most laptops have inbuilt microphone and
speakers.

4 Choose whether you want to play the sound Automatically or to 
be started upon clicking the sound icon by selecting When Clicked  
(Figure 2.7).  

5 Once you have added a sound, the sound icon  appears on 
the slide. Click the sound icon to change how the sound is played 
during the presentation (Figure 2.8).

Figure 2.8. Changing sound options

Figure 2.7. Options to play sound

 Figure 2.6. Recording sound

RecordRecord
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 • Preview: Listen to the sound that will play.
 • Slide Show Volume: Change the volume to low, medium,

high, or mute.
 • Hide During Show: Hide or display the sound icon during the

slide show.
 • Loop Until Stopped: Repeat the sound until it is stopped  by

the user.
 • Max Sound File Size (KB): Change the maximum sound file

size.
 • Play Sound: Play sound automatically, when clicked or play

across slides.

B. Adding Video
1 Click on Insert > Movie (Figure 2.9).

2 Choose an option from the drop down list. You can either choose 
a video file from the computer or a video file that comes with MS 
Office package (Figure 2.10).

3 Select the movie that you want to insert.

4 Choose to play Automatically or When Clicked.

 Figure 2.10. Options to add video files

Figure 2.9. Movie option under Insert view
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5 Once you have added a video, rectangular video screen appears 
on the slide. Click the screen to change how the video is played 
during the presentation (Figure 2.11)

 • Play Movie: Play automatically, when clicked, or play across
slides.

 • Hide During Show: Hide or Show icon during the slide show.
 • Play Full Screen: Play the video full screen.
 • Loop Until Stopped: Repeat the video until it is stopped by

the user
 • Rewind Movie after Playing: Rewind the video to the

beginning after playing.

Try This on Machine

Open the presentation file TransportSystem and do the following 
tasks:
1. In the first slide, insert the music Sleep Away from the sample

music folder. Make it to play across all the slides.
2. In the last slide, insert the sample video Wildlife from the

sample video folder. Make it play when clicked.

Note
Once you have added video to the slide, you can resize or move it to fit the slide. 
It is always wise to keep the multimedia files such as sounds, videos and pictures, 
and presentation file together in one folder so that you can easily find them later 
when you need to use in other computer. 

       Figure 2.11. Changing video options
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2.3 Animation in MS PowerPoint

Animation is the process where multiple objects are displayed in a 
sequence such that the objects appear to be in motion. Animations are 
widely used in presentations to:

» put emphasis on important points;

» control the flow of information, and

» give life to the presentation.

In MS PowerPoint, animations are added either to text and graphics in 
a slide, or when one slide moves to another slide. Let us look at how to 
animate text and graphics in a slide.

1 Select the object to be animated

2 Click on Animations tab > Custom Animation. The Custom
Animation task pane appears.

3 Click on Add Effect and select one of the options (Figure 2.12).

Figure 2.12. Animation options

 • Entrance: Add animation effect to text or object when it
appears in a presentation.

 • Emphasis: Add animation effect to text or object already
shown on a presentation.

Four options 
to add effect to 

an object
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 • Exit: Add animation effect to text or object when it leaves the
presentation.

 • Motion Paths: Add animation effect to text or object so that it
moves in a specified path.

4 Animation effect can be modified by applying Modify effect. There 
are three options (Figure 2.13).

Figure 2.13. Modify options

 • Start: Options to start animation.
• On click: User starts the animation with the click.

• With previous: User has no control. Animation starts
at the same time as the previous animation.

• After previous: User has no control. Animation starts
when the previous animation stops.

 • Direction: Direction from where to start animation. This will
vary depending on which Effect you have chosen. Directions
can be From Top, From Right, From Left and From Bottom.

 • Speed: Pace at which the animation happens. Speeds vary
from Very Slow to Very Fast.

Three options to 
modify effects
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5 After applying more than one animation to a slide, we may wish to 
make some changes (Figure 2.14).

Figure 2.14. Custom animation pane

 • To change the order of how different animations appear in
a presentation, select the animation > use Re-Order arrows
at the bottom of custom animation pane or simply drag and
drop.

 • To remove an animation, select the animation > click on
Remove button or right click on the animation > click on
Remove button.

 • To preview how the animation will play, click on Play button.
 • To change animation effect to another, select the animation >

click on Change button.

Change to other 
animation effect

Preview the 
selected effect

Remove the 
animation effect

Selected effect

Reorder the 
slide effect.
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Try This

Open the presentation TransportSystem that you have created from 
Figure 2.2. Save the file as AnimatedTS.
1. Make the title and the text in the second slide appear on mouse

click.
2. Make the car and the bus to move using Motion Path.
3. Apply Grow/Shrink emphasis on the aeroplane in the fourth

slide.
4. Apply exit effect Fly Out on the text and the image in the fifth

slide.

2.4 Slide Transition

In cartoon movies, the switch from one scene to another happens with 
some fading or sliding effects. Animation effects used when moving 
from one scene to another is called transition. In MS PowerPoint, 
motion effects occurring in presentation view when you move from 
one slide to another is called slide transition. Adding slide transition 
determines how a slide appears.

A. Adding Transition
1 Select the slide you wish to add transition.

2 Go to Animations tab >Transition to This Slide group > Choose a 
transition from the transitions gallery (Figure 2.15). 

3 Slide transition can be modified by using options under 
Transition to This Slide (Figure 2.15).

Figure 2.15. Slide transition options
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 • To add a sound effect, choose a preset sound from
the Transition Sound drop-down menu or choose Other
Sound to use a sound from your computer.

 • To change the speed of transition, select a speed (Slow,
Medium, Fast) from the Transition Speed drop-down menu.

 • To apply the current transition settings to all slides, click Apply
To All.

 • To apply how your slide advances, check On Mouse Click or
set a time for the slide to advance automatically.

B. Removing Transition
To remove transitions from slides, select the slide > Animations tab > 
Transition to This Slide group > Select No Transition from transitions 
gallery (Figure 2.16).

Figure 2.16. Transition gallery

Try This

Open your presentation AnimatedTS. 
1. Apply different transition to the slides.
2. Change the speed of the transition in second slide.
3. Add transition sound for the third slide.
4. Make the transition to appear on mouse click.

No Transition effect
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2.5 Saving in Other Formats

In MS PowerPoint, you can also save a presentation in PowerPoint 
Show format (Figure 2.17) to run the presentation automatically and 
continuously. PowerPoint Show format is commonly used in shopping 
centres to advertise products and in exhibition centres to display 
information to public. 

MS PowerPoint presentations can also be saved in graphic formats 
such as GIF, JPEG, PNG, and TIFF (Figure 2.18). While saving in 
graphic formats, options are available to save all slides or single slide 
(Figure 2.19). 

Tips to create a good presentation
 \ Add animation only if it enhances the points you want to 

communicate. Adding an animation that does not support your 
message only distracts the audience.

 \ Do not always add sound in slide transition. It may distract the 
audience after every slide or disrupt the continuity of presentation.

 \ Do not use too many transition and animation effects within a 
single presentation as they can distract the audience.

Change the Save as 
type to PowerPoint 
Show in the Save As 
dialog box.

Figure 2.17. Saving in PowerPoint Show format
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Figure 2.18. Saving in graphic formats

Figure 2.19. Options to save one or all slides

Try This on Machine

5. Change the presentation TransportSystem into a PowerPoint
Show and view it.

6. Convert all slides from the presentation AnimatedTS into a
picture format.

Now you know

1. Slide Master is used to apply a design or layout to all the slides in a
presentation.

2. Audios and videos makes the presentation interesting.

3. Animation moves the objects to make the presentation lively.

4. Slide transition adds effect to slides when moving from one slide
to another.

5. MS PowerPoint files can be saved in other formats such as
PowerPoint Show and graphics.
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Check Your Progress

Read the following story and design a presentation in MS PowerPoint. 
 • Give an appropriate title to your presentation.
 • Insert pictures, audios and videos if necessary.
 • Apply animations.

(Hint: Mention the background of the farmer. List the challenges he faces. 
Provide some suggestions for farmers in general to make a better living.)

Migsel is a 50 year old farmer and lives with his wife and 3 children 
at Yurung in Pema Gatshel. All of his children go to school, the el-
dest is studying in Thimphu. Migsel had served in the Royal Bhutan 
Army for 23 years and retired 5 years ago.

He and his wife own only 0.2 acres of dry land on which they grow 
barley (October to March) and maize (March to September). The 
yield is not very high as he does not have any cattle to supply him 
with dung to make manure. 

Sometimes he works as a supervisor wherever the Dzongkhag has 
public works to do such as road construction. His wife weaves the 
cloth which are made into garments for the family. He reserves 
some of the land near the house as a vegetable garden where he 
grows lettuce, radish, potato and leeks. He cannot sell the surplus 
vegetables because the market is too far away. Some of the vegeta-
bles are dried and stored for the family to use in scarce seasons.

With the money he earns and the yields from his little farm, Migsel 
can just keep his family going. His land is really too small to yield 
surplus for extra earnings. His parents had to divide their land 
among seven children. He sends his children to school hoping that 
they will find their own way of making a living without having to 
depend on the share of his 0.2 acres of land.

(Source: Class 8 Geography textbook, page No. 33)
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Explore Further

PechaKucha (Figure 2.20) is a presentation style in which 20 images 
in 20 slides are shown for 20 seconds each (6 minutes and 40 seconds 
in total). Images advance automatically while presenter talks along 
with the images. It allows a concise presentation. Visit the Pechakucha 
website (www.pechakucha.org) for more information. 

Figure 2.20. PechaKucha website

Task: Make a presentation in PechaKucha 20X20 format in MS 
PowerPoint on any topic of your choice and present it to your class.
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Web Links

1. Animation
 K http://www.baycongroup.com/powerpoint2007/03_powerpoint.htm
 K http://inpics.net/tutorials/powerpoint2007/list.html
 K http://gethelp.library.upenn.edu/workshops/biomed/ppt07/animation07.

html

2. Slide Master
 K http://www.gcflearnfree.org/powerpoint2007/16

3. Saving MS PowerPoint to other formats
 K http://www.shapechef.com/blog/understanding-powerpoint-file-formats
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In this Chapter
3.1   Audio
3.2   Recording Audio
3.3   Introduction to Audicity
3.4   Features of Audicity Window
3.5   Recording or Importing Audio
3.6   Editing Audio
3.7   Applying Audio Effects
3.8   Mixing in Audacity
3.9   Saving in Audacity
3.10 Audio Sharing

Learning Objectives
1. Record audio using simple recording

program.
2. Install and uninstall audio editing

software.
3. Edit audio files using audio editing

software.
4. Share audio files on the Internet

3
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3.1 Audio

Audio is one of the elements of multimedia. It may be in the form 
of speech, narration, songs and music. Audio is used to enhance 
multimedia in many ways. For example, sound effects are used 
in  movies to make it dramatic, or background music is played in a 
presentation to draw the attention of audience. 

Audio is saved in different file formats. Some common audio file 
formats are given in Table 3.1.

Table 3.1 Audio file formats

Format File Extension Brief Description
MPEG Layer 3 .mp3 Most commonly used sound file format. Au-

dio data is compressed.

Windows Me-

dia Audio

.wma Standard file format used by Microsoft. Audio 

data is compressed.

Waveform 

Audio File 

Format

.wav Main file format used on Windows comput-

ers for raw and uncompressed audio. It can be 

large in size-around 10 MB per minute. Since 

it is uncompressed, audio can be easily edited 

using software.

Advanced Au-

dio Coding

.aac Standard audio file format used in YouTube, 

iTunes and PlayStation 3. It is official succes-

sor to MP3 format. Audio data is compressed.

Audio Inter-

change File 

Format

.aiff Standard audio file format used by Apple for 

uncompressed audio. Often used by sound 

editing studio. 

Vorbis .ogg A free container format which compresses to 

smaller size than MP3 files.
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3.2 Recording audio

Windows 7 comes with an application called Sound Recorder to record 
sound. The recorded audio is saved in Windows Media Audio 
(.wma) file format.  To open Sound Recorder,  

1 Go to Start > All programs > Accessories > Sound Recorder. 
The Sound Recorder dialog box will appear.

2 Click on Start Recording button as shown in Figure 3.1(a) 
and start recording sound. Click on Stop Recording button 
as shown in Figure 3.1(b) when the recording is completed. A 
Save As diaglog box appears.

Figure 3.1. Sound Recorder

3 Give a file name and save the recording. If you close without 
saving the file, an option to continue the recording appears. 
Click on the Resume Recording button (Figure 3.2) to 
continue.

Figure 3.2. Resume recording

Note
Before recording, make sure that;
• you have microphone connected to audio input port.
• you adjust the sound level in the Volume Mixer. If it is on Mute, you won’t

be able to record.

(a) Start recording (b) Stop or pause recording
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Try This on Machine

1. Record a sound in Sound Recorder and save it as
MyFirstSoundRecord.

2. Record a sound directly from MS PowerPoint (Insert tab >
Audio > Record Audio). How is it different from the sound
recorded in Sound Recorder?

3.3 Introduction to Audacity

Sound Recorder is a basic tool meant only for recording sound. Quite 
often, we cannot use the recorded sound from the Sound Recorder 
due to loud background noise, low sound volume, unwanted breaks 
in between,  no sound effects, or limited file format. Such tasks can be 
done using sound editing software such as Audacity.  Audacity is a 
free software for recording and editing sound. It is simple and easy to 
use.

When any application is installed, various files are copied to the 
computer to make the program ready for use. The process of making a 
program ready for use on a computer is called installation. 

A. Installing Audacity
To install Audacity on a computer, we need an installer file that is 
available for download (http://audacityteam.org). Audacity installer file 
is different for Window, Mac and Linux. 

The following steps are involved to install Audacity.

1 Double click the installer file.

2 Follow the instructions in the setup process (like selecting the 
language, license agreement, destination location).
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3 Click on Finish button to complete the installation. A 
shortcut icon appears on the Desktop. Audacity is now ready 
for use.

B. Uninstalling Audacity
Programs that you no longer use in your computer can be removed. 
Removing programs that are not used creates free space on the hard 
disk. 

To uninstall a program, go to Control Panel > Programs > Programs
and Features > select the program to be removed (Figure 3.3) > Click 
on Uninstall.

Figure 3.3. Uninstalling program

Try This on Machine

1. Install Audacity in your computer.
2. How many space is taken by Audacity on hard disk?
3. Uninstall Audacity.

Note
Only the user with administrator right can install a program. 
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3.4 Features of Audacity Window

Start the program from Start > All Programs > Audacity. 

Figure 3.4 shows the features of Audacity window.

1. Transport Toolbar: It has buttons for controlling playback,
recording and for moving to the project's start or end. The buttons
can also be controlled with keyboard shortcuts.

2. Mixer Toolbar: Tools to adjust recording volume and playback
volume.

1

2

3

5

7

6

8

9

11

4
10

Figure 3.4. Audacity Window
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3. Device Toolbar: Provides an easy way to select your required
combination of audio host, recording device, recording channels
and playback device.

4. Track Control Panel: Contains controls and status indicators for a
track.

5. Tools Toolbar: Allows you to choose various tools for selection,
volume adjustment, zooming and time-shifting of audio.

6. Meter Toolbar: Displays the amplitude of audio being recorded or
played in the project.

7. Transcription Toolbar: Lets you play audio at a slower or faster
speed than normal.

8. Edit Toolbar: Allows you to perform editing functions such as
copy, cut, paste and zoom.

9. Timeline: Indicates the position of sound.
10. Audio Track: Recorded or imported tracks are shown with wave

to indicate the amplitude of the sound.
11. Selection Toolbar: Displays information on specific selection

made on the track such as length, starting and ending point of a
selection in terms of time.

3.5 Recording or Importing Audio

Sound files in Audacity can either be imported from other folders or 
recorded directly in Audacity.

» To import sound files, select File > Import > Audio. By default,
Audacity only supports certain file extensions (.wav, .aiff, .flac,
.mp3, and .ogg). However, other sound formats can also be
imported using a plugin (ffmpeg) that can be downloaded from
the website.

» To record sound files, click on the Record button . Waves on the
interface can be seen changing according to recorded voice.
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Audacity allows users to add or record more than one sound file. 
The added sounds are shown in separate layers and are called tracks 
(Figure 3.5). Having tracks allows the editor to apply different sound 
effects to each recording separately.

Figure 3.5. Multiple tracks 

The playback of tracks in Audacity can be controlled using tool buttons 
in Transport toolbar (Figure 3.6). 

  Figure 3.6. Transport toolbar

 • Pause button : To pause playback or resume the play.
 • Play button : To start playback.
 • Stop button : To stop a playing track or recording.
 • Skip to Start button : To skip the cursor at start of the track.
 • Skip to End button : To skip the cursor at end of the track.

You can also use the Transport menu (Figure 3.7) or the shortcut keys 
to control the playback of tracks. 
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Figure 3.7. Transport menu

Try This on Machine

1. Import a sound file to Audacity.
2. Record a sound in Audacity.
3. Use the toolbar buttons or shortcut keys to play the sounds.

3.6 Editing Audio

Sound editing involves recording, modifying, mixing and adding 
effects to sound. The person who does such a work for music, TV, film 
or video game is called sound editor.

Selection is the fundamental step in sound editing. We select the audio 
in full or a part to perform any editing. To select a part of the audio, 
click and drag using the Selection tool , or click at one point of the 
track and hold down shift key while clicking at the other point of the 
track. 

Some common editing tools available in Edit Toolbar are:

Shortcut 
keys
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 • Cut : Removes the selected audio data and places these on the
clipboard. By default, any audio to right of the selection are shifted
to the left. (Ctrl + X)

 • Copy : Copies the selected audio to the clipboard without
removing these from the project. (Ctrl + C)

 • Paste : Inserts the copied or cut audio data at the position of the
selection cursor. (Ctrl + V)

 • Delete : Deletes a selected audio from the track. (Ctrl + K)
 • Duplicate : Creates a duplicate of selected audio into a new layer.

(Ctrl + D)
 • Split : Splits the track from the place of cursor. (Ctrl + I)
 • Trim Audio : Keeps only the selected audio and deletes all. It does

not affect other separate clips in the same track. (Ctrl + T)
 • Silence Audio : Silences the currently selected audio. (Ctrl + L)
 • Zoom Selection : Zooms a selection region in or out so that it fits

in the available horizontal window area. (Ctrl + E)
 • Fit Project : Zooms in or out so that the entire audio of the project

fits in the available horizontal window area. (Ctrl + F)

Try This on Machine

Import the sound file Sleep Away from sample music in your 
computer and edit the audio using Edit Toolbar.

3.7 Applying Audio Effects

Effects are added to original sound to modify and make the sound 
clear, soothing and interesting. However, having too many effects make 
the audio noisy and unpleasant. Sound effects are effective if timed well 
and used appropriately. 

Some useful sound effects in Audacity for the beginners are:
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 • Amplify: To change the volume of the selected track. (Effects >
Amplify)

 • Fade In: To apply a fade to the selected audio such that the
amplitude goes from absolute silence to the original amplitude
(Figure 3.8). (Effects > Fade In)

Figure 3.8. Fade In Effect

 • Fade Out: To apply a fade to the selected audio such that the
amplitude goes from the original amplitude to absolute silence
(Figure 3.9).  (Effects > Fade Out)

Figure 3.9. Fade Out effect

 • Noise Reduction: To reduce constant background noise such as
fans, tape noise, or hums. (Effects > Noise Reduction).

 • Echo:  To repeat the selected audio again and again, normally
softer each time. (Effects > Echo)

 • Change Speed: To change the speed of a track and also to change
its pitch. (Effects > Change Speed)

 • Vocal Remover: Attempts to remove vocals from a stereo track.
(Effects > Vocal Remover)

 • Bass and Treble:  To increase or decrease the lower frequencies  
and higher frequencies of audio independently. (Effects > Bass
and Treble)
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Try This on Machine

Import a sound file from your computer to Audacity and apply the 
following effects.
1. Fade In effect for first 10 seconds
2. Fade Out effect for last 20 seconds.
3. Increase the Speed in the middle of the audio.
4. Echo for 10 seconds in the middle of the track.
5. Change the Amplify, Bass and Treble for 10 seconds of the

audio.

3.8 Mixing in Audacity

Sometimes we need to combine multiple audio files such as dialogue 
and background music for a movie, or mix two or more songs for 
school cultural show.  In such cases, Audacity allows mixing of audios. 
Mixing refers to the process of combining multiple tracks into a single 
track. Audacity mixes tracks automatically when playing or exporting.

To mix multiple songs in Audacity, the steps below are followed.

1 Import three songs, one at a time. Each song will be 
automatically placed in separate tracks.  Figure 3.10 has three 
tracks named Kalimba, Sleep Away and Maid with the Flaxen 
Hair.

Figure 3.10. Importing multiple tracks

ICT Textbook Class 8_2019_CRC.indb   42 7/17/2019   4:51:17 PM



Chapter 3 Working With Audio

43
Reprint 2019

2 Use Time Shift Tool to move the starting position of second 
and third tracks so that these tracks play later than the first 
track. In Figure 3.11, Sleep Away starts after 30 seconds and 
Maid with the Flaxen Hair starts after 60 seconds.

Figure 3.11. Time shift tool

3 Edit the tracks by applying some sound effects. In Figure 
3.12, tracks are split into parts. The parts are either deleted 
or rearranged. Fade In effect is applied to the first part of 
Kalimba and Fade Out is applied to last part of Sleep Away.

Figure 3.12. Editing tracks

Time Shift 
tool
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4 Once the editing is complete, it is important to save the file. 
Audacity allow us to either save as Audacity project or export 
to other file formats. 

Try This on Machine

Import some songs into Audacity. Add effects and save it as a single 
song in MP3 format. Name it as MixedSongs. 

3.9 Saving in Audacity

Depending on how you want to use, audio in Audacity can be saved in 
two ways. 

A. Saving as Audacity Project
Saving as Audacity project file (File > Save Project OR Ctrl + S) allows 
user to easily make changes to the file in future. Editing and mixing is 
possible only in this format. It uses the file extension .aup. It is not an 
audio file and we cannot play it in audio players. However, files saved 
as Audacity projects can be exported to other formats by using Export 
Audio under File menu.

B. Exporting to other formats
Exporting files to other formats (File > Export Audio OR Ctrl + Shift + 
E) allows user to play the audio on music players. By default, Audacity
can export files to WAV, AIFF, Ogg Vorbis, FLAC and MP2 formats. To
export as MP3 format, the optional Lame MP3 encoder must be first
installed. We can also install the optional FFmpeg library to export to
other audio formats such as WMA and MP4.

While exporting, title and artist can also be added to make it easier to 
identify in audio players (Figure 3.13). 
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Figure 3.13. Track labels

Try This on Machine

Record any poem from your English textbook in Audacity. Edit 
your recording using effects like Noise Reduction, Amplify, Fade In 
and Fade Out to make your recording audible and clear. Save it as 
an audio file.

3.10 Audio Sharing

Audio can be shared through many ways. Some use USB storage 
devices and CDs, while others use online audio sharing platforms. One 
of the popular online audio sharing platforms is SoundCloud (https://
soundcloud.com). SoundCloud is a free service for uploading your 
own audio files and finding those created by others. It also allows users 
to add comments, create groups, add  Like, and download audios. The 
tracks that you like can also be shared on Facebook and Twitter. 
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A. Uploading an Audio Clip in SoundCloud
We need to sign up a free account in SoundCloud (Figure 3.14) in 
order to upload audios. SoundCloud also allows you to sign in with a 
Facebook account.

Once you have signed into SoundCloud, follow the steps below to 
upload an audio clip:

1 Click on the Upload button in the header of the webpage 
(Figure 3.15).

Figure 3.15. Page header

2 Click on Choose file to upload (Figure 3.16) and select the 
audio file from your computer. It will take some time to 
upload. Add some tags or descriptions and save it.

Sign up 
for a new 
account  

Click here 
to upload 
an audio 
from your 
computer

Type here to 
search for artists, 
band, tracks, 
podcast

Popular 
audio in the 
community 
(trending) is 
shown here

Figure 3.14. Homepage

Sign in 
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Figure 3.16. Selecting file

3 Once the uploading is over, click at Home button and you will 
see the file that you have just uploaded on the webpage (Figure 
3.17). 

Try This on Machine

Sign in to SoundCloud and upload the poem that you have earlier 
recorded and edited in Audacity. 

Figure 3.17. Uploaded file

Time 
when the 
audio was 
uploaded

Profile 
picture  

Uploaded 
audio file  

Comments, 
Likes, Share 
and Add to 
group  
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Now you know 

1. Computer requires sound card and microphone to record
sound.

2. Sound Recorder is a Windows utility tool to record
sound.

3. Uninstalling programs that are no longer in use will free
up hard disk space.

4. Audacity is a free software for recording and editing
sound.

5. Multiple tracks can be edited in Audacity to make them
clear and interesting.

6. Audio is exported from Audacity to make it playable on
an audio player.

7. SoundCloud is a free online service for sharing audio
files.

Check Your Progress 

1. Observe the screenshot in Figure 3.18 and answer the
following questions.
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Figure 3.18. Audacity window

a. What is the name of the project?
______________

b. How many tracks are there?
___________________

c. Write the names of the tracks.
___________________

d. Which track(s) has been split into two
parts?________
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e. What is the duration of the shortest track?
__________

f. Name the tracks with Fade In effect.
__________

g. Name the tracks with Fade Out effect.
__________

h. Which track(s) will play if you click on the Play
button?  _______________

2. Using SoundRecorder, record the quotes in the box.
Import it in Audacity and add a background music. Save
it as GreatQuotes.

Inspiring Quotes

A person who never made a mistake never tried any-
thing new. – Albert Einstein

We can easily forgive a child who is afraid of the dark; 
the real tragedy of life is when men are afraid of the 
light. – Plato

The ones who are crazy enough to think that they can 
change the world are the ones who do. – Steve Jobs

It isn’t the mountains ahead to climb that wear you 
down. It’s the pebble in your shoe. – Muhammad Ali

Do not pray for an easy life, pray for the strength to en-
dure a difficult one. – Bruce Lee 
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Explore Further

Sing and record the following four stanza of the song given in 
the box in Audacity. 

 • Add a background music.
 • Adjust the sound level so that the music plays more softly.
 • Add effects (like fade in, fade out, echo, noise reduction) to

your song.
 • Save it as MP3 format.

ཡོན་ཕུ་ལ། – by Misty Terrace

[Verse 1]

ལྷ་ཡི་ཞིང་ཁམས་ ཡོད་ར་ཡོད་ལོ། 
བུམ་ཁྱོད་མཐོང་སྟེ་ཧ་གོ་ཡི།
སེམས་དགའ་བའི་དུས་ལུ་ སླབ་ཨིན་པས།
རྒྱབ་སྒྱིར་ཏེ་བལྟཝ་ད་ ཁྱོད་ར་འདུག
ཁྱོད་ཚར་གཅིག་མཐོང་རུང་ སེམས་དགའ་བས།
ང་དང་ཁྱོད་ཀྱི་ གཏམ་གཅིག་འདུག
[Chorus]
ཡོན་ཕུ་ལ་ལས་ ཨེ་ཏོ་མེ་ཏོ་འབག་སྟེ།
གྲང་མེད་ཆུ་ན་ བཀོ་བ་ཕངས་མས་སོ།
ཁྱེགས་སི་སི་ གཡང་རྩེ་གི་རླུང་མ་གོ་སྟེ།
སྔུཝ་མས་ ཞབས་ཁྲ་འཐེན་མས་ ངེའི་དོན་ཧིང།
ལ་ལ་ལ་ལ་ལ་ལ་ལ་ལ་ལ་ལ་་་་།

[Verse 2]

ཁྱོད་ཀྱི་དགའ་འཛུམ་ ཁྱོད་ཀྱི་མིག་ཏ་གིས་
ངེའི་དོན་ཧིང་ ཨརཝ་ཤོར་ ང་མ་ཤེས་ས།
འཛམ་གླིང་ནང་གི་ ཨརཝ་ཟེ་སོམ་ར་ཁྱོད།
ཚར་གཅིག་ཉལ་བའི་གཉིད་ལམ་ན་ལུ་མས།
ཁྱོད་ཀྱི་ཐག་རིང་ས་ ཡལ་ཡར་སི་ས།
དོ་པ་ལོངམ་ད་ ཧང་གུ་མིག་ཆུ་མས།
[Chorus]
ཡོན་ཕུ་ལ་ལས་ ཨེ་ཏོ་མེ་ཏོ་འབག་སྟེ།
གྲང་མེད་ཆུ་ན་ བཀོ་བ་ཕངས་མས་སོ།
ཁྱེགས་སི་སི་ གཡང་རྩེ་གི་རླུང་མ་གོ་སྟེ།
སྔུཝ་མས་ ཞབས་ཁྲ་འཐེན་མས་ ངེའི་དོན་ཧིང།
ལ་ལ་ལ་ལ་ལ་ལ་ལ་ལ་ལ་ལ་་་་།
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Web Links

1. Sound Recorder
 K http://www.digitalcitizen.life/record-audio-sound-recorder-windows-7

2. Audacity
 K http://audacityteam.org
 K https://engims224cfall2013.files.wordpress.com/2013/08/

audacityworkshop.pdf 
 K http://manual.audacityteam.org/o/man/faq_installation_and_plug_ins.

html#ffdown 
 K http://www.makeuseof.com/tag/7-audacity-tips-better-audio-editing-

budget/
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In this Chapter
4.1   Malware
4.2   Types of Malware
4.3   Ways to Prevent Malware Infection
4.4   Antivirus

Learning Objectives
1. Define malware.
2. Identify different types of malware.
3. Explain types of malware.
4. Apply ways to prevent malware

infection
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4.1 Malware

Malware is the short form for malicious software. It is a general 
term used to describe all harmful software that intends to gain access 
to computer or disable computer system without the knowledge of 
the user. Malware can steal passwords, delete files, access personal 
information, or even stop a computer from working at all.

In early 1980s, malware was created for fun. With the advancement 
of computer technology and its wide range of uses, it was found that 
malware can be used to gather other’s personal information. Malware 
is created by those who try programming skills or by professional 
programmers to gain access to other’s computers. The majority of 
malware are created for unlawful activities. Some of the reasons 
malware get created are to:

» make money either by tricking users to buy and download
software or persuade users to look at advertisements;

» access personal information and misuse them for illegal activities;

» cause problem to computers and networks such as slowing down
computer or crashing an entire network system;

» gain popularity for the malware creators as it involves skills of
complex programming ; and

» spy on user’s activities on the computer.

Computers and networks get infected with malware through many 
ways. Some of the ways are through:

» downloading unknown files from the Internet;

» installing software from unidentified source;

» opening email attachments from unknown senders; and

» using infected USB devices.

ICT Textbook Class 8_2019_CRC.indb   54 7/17/2019   4:51:31 PM



Chapter 4 Malware Prevention

55
Reprint 2019

4.2 Types of Malware

There are different types of malware depending on their characteristics 
and the way they infect computers. The following are some of the 
common types of malware.

i. Virus

A virus is a program that infects files and software in a system.
It passes from one system to another with the help of a host file.
When a user runs or opens the host file, virus activates and spreads
itself to other programs. Virus can alter, duplicate or delete files
and programs.

ii. Worm

A worm is a malicious program that replicates itself in order to
spread to other computers. It is similar to viruses except that it
spreads copies of itself without the use of a host file and does not
change files. Worms are not always destructive, but they can slow
down a computer or network by consuming system memory.

iii. Trojan Horse

It is a type of malware that disguises itself as a genuine program to
trick users into installing it. Once installed, it opens access to your
computer to a hacker, commonly known as backdoor, without your
knowledge. The hacker can use a Trojan horse to steal financial
and personal information. Unlike virus and worm, it does not copy
itself into other files or spread over the networks.

Do You Know?
Trojan horse was a giant wooden horse within which Greek 
soldiers hid and thus managed to enter the city of Troy. At night, 
the soldiers came out and opened the city gates to let in Greek 
army, thus ending the 10-year long Trojan War.
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iv. Spyware

Spyware is a program that secretly gathers information about
a person or an organization to send it to advertisers or other
interested parties. It usually tries to capture passwords, banking
details, email addresses, and monitor web browsing activities on
the computer.

v. Ransomware

Ransomware, also called as scareware, is a type of malware that
blocks or limits user’s access to their system or files by locking
them unless a ransom is paid. Ransomware can prevent users
from accessing Windows, encrypt files, or stop the function
of applications in a system. Ransom operators mostly ask for
payments in a digital currency called Bitcoins because it offers
anonymity. Ransom price depends on the type of ransomware
and the price of digital currencies. Paying ransomware does not
guarantee that users will get the unlock tool to regain the access.
Therefore, a way to minimize the impact of ransomware attack
is to back up your data in other storage device like external hard
drive or CDs.

Try This on Machine

Find information on some of the popular computer malware like 
Morris, Mellisa, ILOVEYOU, Anna Kournikova, and Michelangelo 
from the Internet. Categorise them into different types of malware.

4.3 Ways to Prevent Malware Infection 

When computers start slowing down or behaving in an unusual way, 
it is likely that the computer is infected with malware. Given below are 
some signs of an infected computer:
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» Computer starts to slow down.

» Unexpected messages or images appear on the screen.

» New icons or wallpaper or toolbars show up.

» Default homepage or search engine redirects to other sites.

» Programs start unexpectedly without user’s command.

» System error messages appear frequently.

» Files and folders get deleted or changed without user’s instruction.

However, the malware infection can be prevented by following certain 
preventive measures which are given below:

» Use genuine operating system. Keep your operating system
updated.

» Use genuine application software.

» Do not open attachment and web links in your email unless you
know the sender.

» Avoid clicking advertisements given on websites. They may install
spyware and track your browsing habits without your knowledge.

» Avoid creating accounts on suspicious websites. Your account
could be used to distribute malware to others.

» Avoid downloading files and programs that seem suspicious or are
from an unfamiliar source.

» Install an antivirus software on your computer. This is the first step
towards protecting your computer from malware.

» Keep your antivirus software up-to-date so that new viruses can be
detected and cleaned.

» Always scan storage devices like USB drives with updated antivirus
before you open them.
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4.4 Antivirus 

Antivirus is a small program that is developed to prevent, search, 
detect, and remove viruses and other forms of malware from the 
computer. There is a common misunderstanding that antivirus 
software only protects against viruses. Antivirus actually protects 
against all types of malware. There are both free and paid antivirus. 
Some popular antivirus software are:

» Kaspersky

» Avira

» McAfee

» Avast

» Anti-Virus Guard (AVG)

» ESET NOD32

» Microsoft Security Essentials

» Windows Defender

Try This on Machine

Find out the antivirus software installed in computers in the 
computer laboratory.

Note:
Installing more than one antivirus does not necessarily improve the security. In 
fact they may interfere with one another and slow down the computer.
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A. Updating Antivirus
Antivirus companies keep record of different virus patterns. This 
record kept is called virus signature database. Virus signature is a 
string of characters or numbers. Virus authors continually release new 
and updated viruses. Antivirus experts study the patterns of these new 
viruses and update their virus signature database. Therefore, antivirus 
software needs to regularly update to latest virus signature database to 
stay effective against known new viruses (Figure 4.1). 

Figure 4.1. Virus signature version and date

Antivirus programs require Internet connection to be updated. While 
the antivirus is set to automatically update, we can also manually 
update it by opening the antivirus program.

Try This on Machine

Find out the virus signature database of the school computers and 
give feedbacks.

Updated to virus 
signature database 
16075 on 13 Sep 
2017
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B. Scanning Virus
Scanning virus using antivirus refers to searching for known viruses by 
comparing the contents of a file with all virus signature in the database.

To scan for virus, open the antivirus program. Select the files, folders 
or programs to be scanned and click on scan. Once the scanning is 
completed, a list of infected files and viruses will be shown. One of the 
following options can be performed on the infected files.

» Repair: It removes the virus from infected files and files can be
used again.

» Delete: It removes both the virus and the infected files completely
from the system.

» Quarantine: It separates the infected files from the non-infected
files.

Users can set a scanning schedule in antivirus or manually perform at 
any time. But, it is good to perform a full computer scan every week.

If your computer is without antivirus, there are online virus scanning 
services which are free. VirusTotal (www.virustotal.com) is one of 
them (Figure 4.2). It provides service to scan files and weblinks to 
detect viruses, worms and other malware. It is especially useful to scan 
suspicious files or websites.

Figure 4.2. Online antivirus
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Try This on Machine

1. Complete a virus scanning procedure for a file or program in
computer.

2. Scan a website on VirusTotal to check the presence of virus.

Now you know

1. Malware is harmful software that intends to gain access to
computer or disable computer system without the knowledge of
the user.

2. Virus, Worm, Trojan and Spyware are some common malware.

3. Majority of malware are created for unlawful activities such as
stealing information, spying on users activities, and destroying
computer system.

4. Installing antivirus on a computer is the first step towards
preventing malware infection.

5. There is a risk of malware infection in opening email attachments
from unknown senders.

6. Antivirus needs to be updated regularly to be effective against
new malware.

7. Scanning USB drives before opening them and scanning your
computer regularly are some ways to prevent malware.

Check Your Progress

1. What are some signs of malware infection in your computer?

ICT Textbook Class 8_2019_CRC.indb   61 7/17/2019   4:51:37 PM



Literacy with ICT

62
Reprint 2019

2. What are the risks of outdated virus signature database in a
computer? What should be done to minimize the risks?

3. In groups, prepare an MS PowerPoint presentation on one type
of malware. Mention examples and suggest some ways to prevent
them.

Explore Further 

1. Nowadays, people are increasingly using smartphones not only
to talk to someone but also to browse information, buy and sell
things, meet friends and relatives, and collaborate online. Explain
how smartphones can be proteced against malware infection?

2. Find out more on Bitcoins from the Internet and make a
presentation in MS PowerPoint.

   Web Links 

1. Malware Prevention
 K http://lineshapespace.com/10-tips-on-how-to-prevent-malware-from-

infecting-your-computer/
 K http://www.pcworld.com/article/210891/malware.html

2. Antivirus
 K http://www.webroot.com/us/en/home/resources/tips/pc-security/security-

what-is-anti-virus-software
 K http://www.pctools.com/security-news/what-is-antivirus-software/
 K http://www.slideshare.net/abhijitchintamani/antivirus-and-virus-

powerpoint-presentation
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1. Verify online information before using

it.
2. Differentiate between copyright and

creative commons.
3. Explain restrictions used in creative

commons licenses.
4. Explain types of software piracy.
5. Describe the consequences of using

copyrighted materials or pirated
software.
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5.1 Verifying Online Information

The Internet allows users to easily create, share and store information. 
However, not all the information on the Internet are reliable 
since anyone with an Internet connection can share information. 
Information can come from different sources. Therefore, we must 
verify whether they are accurate, current or from a reliable source 
before using them.

Some widely used verification criteria to evaluate web resources are:

i. Accuracy

To ensure accuracy, it is important to verify the information with
other sources.  We have to check whether the information has been
reviewed and properly referred. A website with information that
cannot be confirmed should never be trusted. Some checklists to
find the accuracy of information are:

 • Is the information presented accurate?
 • Is it free from grammar and spelling errors?
 • Is there any reference mentioned?

ii. Author

It is very important to check who has written the content, whether
the author is an expert on the written topic, and also the author’s
biasness due to affiliation to an organization. Some checklists are
as follows.

 • Who wrote the document?
 • Is the author’s qualification or affiliation listed?
 • Which institution or organization published this document?

Where?
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iii. When and how frequently is it updated?

Fact or statistical information changes within a short period
of time. Therefore, it is very important to check when and how
frequently the web pages are updated. Some checklists are as
follows.

 • Is the information provided current?
 • When was the page created?
 • When the page was last updated?

iv. Objectivity and Fairness

It is important to determine the purpose of the information. We
have to check whether the information are for advertisement,
educational or other purposes. For example, advertisements are
generally to convince customers rather than to inform. We have to
always check for sources with minimum bias. Some checklists are
as follows.

 • What is the purpose of the web page?
 • Is the author fair and neutral?

Try This on Machine

Visit a website and check whether the information is reliable. Use 
the following questions to evaluate.
1. What is the purpose of the site?
2. Who created the site?
3. Is the content bias? How?
4. Is the information accurate and well written?
5. Is the site up-to-date?
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5.2 Copyright©

When we create something original like a song, a photo, a story, a blog 
post or a video, we have the full copyright for that work. What does 
copyright mean? Copyright is the legal right given to a creator of an 
original work for a limited time. The work has to be something one 
has created and must be in physical form like writings, videos, music, 
and computer programs. Copyright is a form of protection given to the 
author or creator of an original work. The copyright symbol © will be 
reflected on all copyrighted materials.

The copyright includes the right to: 

» distribute the work;

» reproduce or make copies of the work;

» display the work (such as artwork);

» perform the work(such as plays, films, music and dance); and

» make Derivative Works (such as modifications, adaptations,
translations) based upon the original work.

Do You Know?
Copyrights do not last forever. Under the current laws, copyright 
protection starts from the moment of creation of the work and 
continues until 50-70 years after the death of the author. When the 
term of a copyright completes, the work falls into public domain, 
which means anyone can copy it and use it without permission.
In Bhutan, the Intellectual Property Division (IPD) under 
Ministry of the Economic Affairs (MoEA) is responsible agency for 
administration of copyright.
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Using or sharing copyright works without the permission of the owner 
is illegal and punishable by law. However, copyright is limited to the 
condition of Fair use. Fair use is the rights given to public to make 
reasonable use of the copyrighted material (for purposes such as 
making comments, news reporting, teaching, or research) without the 
owner’s permission.

Bhutan also has a copyright law - Copyright Act of the Kingdom 
of Bhutan, 2001, which recognises the type of copyright works, 
protects the copyrighted works, and enforces the rights. It also states 
that the rights of the copyright owner shall be protected during the life 
of the author and for 50 years after his/her death.

Try This

In pairs or small groups, discuss whether you own the copyright of 
work mentioned in each of the following cases:
1. You have written a story during an English class. Your teacher

has made some corrections to it. Who owns the copyright of the
story – you or your teacher?

2. You and two friends have done a Science project work. Who
owns the copyright of the project work?

3. You went to www.kuenselonline.com, copied a news report
from the Kuensel and created a MS PowerPoint presentation.
Who owns the copyright to news report?

5.3 Creative Commons License 

Creative Commons (CC) is an international non-profit organisation 
that provides free license to every creator in order to make their work 
available to the public. It was started in 2001 as a way to promote legal 
sharing and modification of original works. Creative Commons license 
is used all over the world, especially in the area of online content. It 
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does not replace copyright but extends it. Licensing our work gives 
others the permission to use it with certain restrictions. 

Creative Commons license uses the combination of four basic 
restrictions. The restrictions are as follows.

Attribution (BY). This requires people who use your works to 
credit it to you in the way you request. Cropping the image to cut off 
your name or replacing your name with theirs is not allowed. 

Non-Commercial (NC). This allows people to use your works as 
long as they are not using it for monetary benefits.

No Derivative Works (ND). This does not allow people to modify 
your works. They can only use your works as it is, without making 
any changes. A derivative work is a work that modifies the original 
copyrighted work. For example, a movie is a derivative work of a novel.

Share-alike (SA). This requires people who create a derivative of 
your works to share it under the identical license as your original work.

Creative Commons licenses automatically includes Attribution 
requirement. To it, we can add other restrictions if required.

For example, this license  lets others remix, twist, and build 
upon the work and need not license their derivative works on the same 
terms. However the new work has to acknowledge the creator and be 
non-commercial.

Try This

1. What does this logo  mean?
2. Dorji wants to register a license from Creative Commons for his

short movie. If you are Dorji, what restriction will you choose
and why?
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5.4 Software Piracy

Software is a set of programs that directs a computer to perform 
a specific operation. Users have to buy software license for one or 
multiple computers to avoid the violation of copyright law. It is 
disrespectful or unlawful to use software without license. The act of 
illegal use, copy or distribution of software without ownership or legal 
rights is called software piracy.

Common types of software piracy are:

i. End-Users Piracy

This occurs when an individual copies and distributes software
beyond the license agreement.  For example, installing single
licensed software into several computers is an End-user piracy.
People often share software without realizing that it is a violation
of copyright law.  End-user piracy is common both in business and
at home.

ii. Internet Piracy

This occurs when software are illegally downloaded from the
Internet. Software are illegally obtained through peer-to-peer file
sharing system or downloaded freely from pirate websites. Internet
piracy also includes the sale of counterfeit software on the Internet
auction or classified advertising websites. It is the fastest growing
form of piracy.

iii. Counterfeiting

The process of making duplicate copies of software and
distributing or selling them is called counterfeiting. It means
producing fake copies of software usually in CDs, making it look
authentic and selling it at low price.
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iv. Hard-Disk Loading

This is often committed by hardware dealers. This form of piracy
occurs when an individual or company sells computers preloaded
with illegal copies of software. This encourages customer to
purchase their product as there is no need to purchase the software
separately.

v. Client-Server Overuse

This happens when too many users on a network use the same
software, at the same time than permitted by the license. This type
of piracy is common in a network where programs are installed in
server.

Try This

Complete Table 5.1 and share your response with friends. Explain 
why you chose that response.

Table 5.1 Table of statements

Check Your Perception Agree Disagree
a. I think that most people copy commercial software

instead of buying it.
b. I think that most students copy commercial software

instead of buying it.
c. I think that most teachers copy commercial software

instead of buying it.
d. I think that most schools copy commercial software

instead of buying it.
e. I have copied commercial software instead of buying

it.

Check Your Attitude Agree Disagree
a. I think it is okay for people such as myself to copy

commercial software instead of buying it.
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b. I think it is okay for people who cannot afford, to
copy commercial software instead of buying it.

c. I think it is okay to share commercial software with
friends who are in need.

d. I think it is okay for people such as myself to copy
commercial software instead of buying it when we
use it for educational purposes.

e. I think it is okay for people to copy commercial soft-
ware to evaluate it for possible purchase.

5.5 Risks and Consequences of Using Pirated Software 

Software piracy is a serious issue as it affects both the profitability of 
software companies and security of users. People may consider it as file 
sharing at a cheaper cost, but it is illegal and violates the copyright law.  
Use of pirated software involves a lot of risk and consequences.

The following are some of the risks of using pirated software.

i. Virus Infection

Pirated software may come with malware that can cause problem
to your computer or gain access to your information. There is
always a risk that people who get your information may use it
against you. Since pirated software may not allow updates, they can
also pose security risk by leaving the system with security holes.
This allows hackers to gain access to a system and interfere with its
operation and data.

ii. Legal Actions

Software piracy is illegal and carries high penalties under
copyright law for users caught in the act. Using pirated software
can lead to imprisonment or payment of the cost of the pirated
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software and other costs, if you are sued by a company for having 
stolen their property. 

iii. Immorality

Software piracy or sharing copyrighted materials is more than a
legal matter. There are ethical and moral considerations too. It is
unfair and considered stealing to use works of other’s creation or
invention without permission. Therefore, we must support artists’
or inventors’ creations and ideas for moral and ethical reasons.

Now You Know

1. All the information on the Internet is not reliable and
need to be verified before using it.

2. Unbiased information with proper referencing is more reliable.

3. It is illegal to use or share copyrighted work without the
permission of the author.

4. Attribution, Non-commercial, Non-derivative works and Share-
alike are four different restrictions to license your work with
creative commons.

Do You Know?
As per the section 30(1) of the Copyright Act of the Kingdom of 
Bhutan, 2001, violation of copyright is punishable by imprisonment 
for a period of up to one year or by a fine of up to Nu.1,000,000 or by 
both.
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5. Creative common licenses are used when authors wants to give
public the right to share, use, and modify the work that they have
created.

6. Software piracy is illegal copying, downloading, sharing, selling,
or installing of copyrighted software.

7. Software piracy is a serious issue and involves a lot of
risks such as virus infection, legal actions, and immorality.

Check Your Progress

1. Read the following scenario and answer the questions that follow:

a. Is downloading the sample music from website stealing?
Why?

b. Is it ethical to download the band’s album without buying it?
Why?

c. What are the consequences of illegal downloading of album
for the band and music industry?

A group of youth in Thimphu formed a music band.
They worked hard and earned enough to record their 
songs. They posted one of the songs for free down-
load on a website to promote their album. However, 
rest of the songs in the album are available for pur-
chase. 
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2. State whether the following statements in Table 5.2 are TRUE or
FALSE.

Table 5.2 Rubrics

3. Assess at least three websites using the rubric in Table 5.3.

Statements True/False
a. Drawings in books are copyrighted.
b. You can face large fines for breaching copyright.

c. You are not allowed to copy music.
d. You are not allowed to copy pictures and sell them.
e. You can be put into prison for breaching copyright.
f. You are allowed to copy whole book for your educa-

tion.
g. Copyright can be bought or sold.

h. You can sell someone else’s copyright without permis-
sion.

i. Children cannot copyright their work.
j. Websites are not copyrighted.
k. There is no need to copyright short stories.
l. Computer software is not copyrighted.
m. You should always seek copyright permission if in

doubt.
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Table 5.3 Rubrics

Name of the student:
Title of website:
Address or URL:

Not Good Good Very Good 
1 2 3

Credibility
a. The author is given.
b. The author’s organization or insti-

tution is given.
c. The author can be contacted.
Accuracy & Currency
d. The information is complete.
e. Spelling or grammar mistakes are

minimal.
f. The date of latest update is given.
g. The information is up-to-date.
Fairness
h. The author is fair and objective.
i. The author provides support for

the information.
j. The sources are listed.
Design & Technology
k. The pictures are relevant and clear.
l. The pages are easy to move

around.
m. The colours are appealing.
n. All of the links are working.
o. The pages load relatively quickly.
Overall – Rate the website   (Total)

 • 15 - 25 = Not Good
 • 26 - 35 = Good
 • 36 - 45 = Very Good
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Explore Further

Wikipedia (https://en.wikipedia.org) is a free online encyclopaedia 
that is written by people who use it. Everyone is allowed to edit 
Wikipedia pages to improve the content and thousands of changes are 
made every hour. 

Write a short report on Wikipedia using following questions.
 • How credible is the information given in Wikipedia?
 • What is the copyright policy if you use or edit the information

in Wikipedia?
 • Would you make changes in contents of Wikipedia? Why?

Web Links

1. Evaluating Web Resources
 K https://www.library.kent.edu/criteria-evaluating-web-resources

2. Copyright and Creative Commons
 K http://www.workmadeforhire.net/the-rest/whats-the-difference-between-

copyright-and-creative-commons/
 K http://www.copyrightkids.org

3. Creative Commons
 K http://whenihavetime.com/2009/02/24/a-guide-to-copyright-and-creative-

commons/

4. Copyright Act of the Kingdom of Bhutan, 2001
 K http://www.moea.gov.bt/wp-content/uploads/2017/07/Copyright-Act-of-

Kingdom-of-Bhutan-2001.pdf

5. Types of Software Piracy
 K http://cs.stanford.edu/people/eroberts/courses/cs181/projects/1999-00/

software-piracy/types.html
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FUNCTION AND OPERATORS

In this Chapter
6.1   String Fuctions
6.2   Mathematical Fuctions
6.3   Logical Operator Blocks

Learning Objectives
1. Use predefined mathematical and

string functions in a program.
2. Use logical operators to make decision.

6
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6.1 String Functions

String functions in Scratch allow us to work with strings. In class six, 
we learned to combine two strings using a string function called join 
block. There are two more pre-defined string functions: letter () of () 
and length of () blocks (Figure 6.1).

Figure 6.1. String function blocks

A. Letter Block
This block returns a single character from a specified position in a 
string. The first character is given in the index 1. Index refers to the 
position of a character in a string.

For example, for the word School, the index for each character is given 
in Table 6.1.

Table 6.1 Index
Word S c h o o l
Index 1 2 3 4 5 6

B. Length Block
This block returns the number of characters in a string. It includes 
spaces and punctuations.

For example, length of the word School is 6 and length of the phrase is 
16 in My school’s name.

Figure 6.2 demonstrates the use of repeat block to read and display 
individual letter in a string.

Reprint 2019
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Figure 6.2. Using repeat blocks

In Figure 6.2 (b), if the name Sonam is entered, the number of 
repetition must be equal to the length of the name, which is 5 times. 
Once the count exceeds the length of the name, the program displays 
the name and stops its execution. The repetition process is shown in 
Table 6.2.

(b) Sample script

Start

Declare Name and count

Enter Name

Name — Name
Count = 1

Say  letter

Wait for 2 seconds

count = count + 1

Say the Name

Is count >
Length of 

name?

Stop

No

(a) Algorithm

Loop Count
Dis-
play

Final Count
(Count+1)

Is count > length of name?

First 1 S 1+1=2 is 2 > 5? à No
Second 2 o 2+1=3 is 3 > 5? àNo
Third 3 n 3+1=4 is 4 > 5? àNo
Fourth 4 a 4+1=5 is 5 > 5? àNo
Fifth 5 m 5+1=6 is 6 > 5? àYes

Table 6.2 Loop
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6.2 Mathematical Functions

There are blocks in Scratch that can perform mathematical functions. 
Some of the blocks are as follows:

A. Round Block
This block rounds off decimal numbers to the nearest integer. Decimals 
that are 0.5 or higher are rounded up, whereas decimals less than 0.5 
are rounded down.

For example, this block  returns the integer 10.

B. ( ) of ( ) block
This block performs mathematical functions like 
square root on a given number and reports the 
result. Other functions (Figure 6.3) in this block 
can be selected from the dropdown list.

For example, this block  returns the 
square root of 9 that is 3 and the block 
returns the value of 10 square that is 100.

C. Pick Random Block
This block randomly picks a number from the 
specified range. The default range is 1 to10, but 
we can also change them as shown in Table 
6.3. The block is useful in creating game and 
simulation programs.

Figure 6.3. Mathematical 
functions

Range Possible Outcome
1 or 2 or 3,…, or 10

0.5 or 0.51 or 0.52,…, or 1

-1 or 0 or 1

Table 6.3 Setting range
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Try This on Machine

1. Write programs in Scratch that:
(a) asks for two words from the user and compare the length of

the words.
(b) asks for a word from the user and checks if the first letter of

a word is P or not.
(c) displays the round-off values of 10.6, -12.456 and 3.16.
(d) displays the square root of 82 in the format - Square root of

82 is 9.055.
2. Draw a flow chart and write a program in Scratch in which

user is asked to guess a number first and then roll a die. Make
the message You are Lucky appear on the screen if the guessed
number matches the number obtained from rolling a die.

6.3 Logical Operator Blocks

Logical operator blocks are used to combine multiple expressions 
to produce a single true/false result. There are three logical operator 
blocks with three Boolean operators: AND, OR and NOT as shown in 
Table 6.4. Logical operator blocks can be stacked inside another logical 
operator blocks to test more than two expressions. This means one 
logical operator block can contain one or more logical operator block 
inside it. 

Table 6.4 Logical operator blocks
Operator Blocks Functions

Reports true only if the two expressions are true

Reports true only if either of the two expressions are 
true

Reports true if the expression is false and vice-versa
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A. AND Block
This block combines two expressions and checks if both expressions 
are true. If both are true, it returns true otherwise, it returns false.

Figure 6.4 shows an example to check whether a person is eligible to 
vote or not as per the eligibility criteria given below:

 • A person must be a Bhutanese, and
 • must be above 18 years.

B. OR Block
This block combines two expressions and checks if either expression 
is true to return true. If one of the expressions is false, it returns true. 
When both the expressions are false, it returns false. 

Figure 6.5 shows an example to check whether a student has passed if 
the score is 40 or more than 40 in the test.

Expression 2: Is age 
above 18 years?

This statement will be 
executed only if user is a 
Bhutanese and is above 
18 years of age.

This statement will be executed if 
user is not a Bhutanese and below 18 
years of age or either the user is not a 
Bhutanese or is below 18 years of age. 

Expression 1: Is 
nationality equal to 
Bhutanese?

Figure 6.4. AND operation
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Figure 6.5. OR operation

C. NOT Block
This block takes only one expression. It returns true if the expression is 
false and false if the expression is true.

Figure 6.6 shows an example to check whether a number entered by 
the user is odd or even.

Figure 6.6. NOT operation

This block returns true if rem is equal to 0 and 
returns true if rem is not equal to 0.

Expression 1: Is score 
equal to 40?

Expression 2: Is score 
greater than 40?

This statement is 
executed if score is 40 or 
greater than 40.

This statement is 
executed if score less than 
40.

Variable rem stores the remainder of num 
divided by 2.

Expression: Is remainder not equal to 0?

This statement gets executed if remainder is 
not 0

This statement gets executed if remainder is 0
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Try This on Machine

Draw flow charts and write Scratch programs for the following 
situations.
1. Promotion of students to next class.

To get promoted, a student must pass in 5 subjects and must get a minimum
total of 300 marks.
(Hint: Ask user to enter number of subjects he/she has passed and the total
marks scored)

2. Identify a colour as primary or secondary colour.
(Hint: Ask user to enter any colour and display the output as primary or
secondary; red, blue, and green are primary colours)

3. Compare two numbers.
(Hint: use NOT operator to show that two numbers entered by the user are
equal)

Now You Know
1. Function blocks like join, letter and length blocks manipulate

strings.

2. Letter block returns a single character from a specified position in
a string.

3. Basic mathematical functions can be performed using pick
random, ( ) of ( ), and round blocks.

4. Round block rounds off decimal numbers to the nearest integer.

5. Boolean operators are used to combine multiple expressions to
produce a single true/false result.

6. AND, OR and NOT blocks are Boolean operator blocks.

7. AND block returns true only if all the conditions are true.
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8. OR block returns true if at least one of the conditions is true.

9. NOT block reverse the result of a condition.

Check Your Progress
1. Write TRUE or FALSE for the following statements:

a. Logical operators combine only two expressions.

b. The index of the first letter in a string is 0.

c. OR block returns true even if one expression is false.

d. The ( ) of ( ) block finds only the square root a given number.

e. AND block returns true if one of the conditions is true.

f. Length block does not count space and punctuation.

2. Complete Table 6.5, Table 6.6 and Table 6.7 based on the given
blocks.

a. AND block

Table 6.5 Truth table (AND)
Expression 1 Expression 2 Result

True True
False False

False False
False False

b. OR block

Table 6.6 Truth table (OR)
Expression 1 Expression 2 Result

True True
False True

False True
False False
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c. NOT block
Table 6.7 Truth table (NOT)

Expression Result
True

True

3. Draw a flowchart and write a program that demonstrates the
random motion of gas particles.

4. Draw a flow chart and write a program to check whether two
names entered by the user are same.

Explore Further

1. Create a simple game in Scratch in which the user wins the game
if 3 or more out of 5 guesses are correct. Use sounds, different
costumes and appropriate messages in the game.

2. Create a Scratch program to find the probability of getting 6,
when you roll a die 10 times.

Web Links

1. Logical operators in Scratch
 K http://kkfscs.weebly.com/scratch-operators.html

2. Usage of Pick a random numbers
 K http://wiki.scratch.mit.edu/wiki/Pick_Random_()_to_()_(block)

3. Simple games using random numbers
 K http://www.multiwingspan.co.uk/scratch.php?page=random
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LIST AND CUSTOM
 BLOCKS

In this Chapter
7.1   List Blocks
7.2   Custom Blocks

Learning Objectives
1. Perform operations on a list with List

blocks.
2. Use custom blocks to create functions

and procedures.
3. Solve complex problems using

functions and procedures.

7
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7.1 List Blocks

In Class 7 we learned about variable that stores only a single value. 
To store multiple values, List is used. A List is a variable that stores 
multiple values. Each value is called an item.  Each item is assigned a 
unique number called position number or item number that indicates 
its position in the List. Using position number we can access items in 
a List. Number 1 is assigned to the first item in a list. The total number 
of items in a list is called length of the List. 

Table 7.1 shows the items in the list Fruits.
Table 7.1 Fruits

Item Position
Apple 1
Orange 2
Pineapple 3
Guava 4
Mango 5

A. Creating a List
To create a List, we use Make a List button. Figure 7.1 shows the steps 
to create a List.

Figure 7.1. Creating a list

Step 1: Click on Data

Step 2: Click on Make a List

Step 3: Type list name

Step 4: Click on OK
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List can be declared as global or local. Global list can be accessed by 
all the Sprites in a program whereas local list can be accessed only by a 
particular Sprite. By default it  is declared as a global list.

The blocks in Figure 7.2 are created when we make a list.

Figure 7.2. List blocks

i. Stage Monitor

This displays the List items on the stage.  It can be hidden from the 
stage by unchecking the check box as shown in Figure 7.3.

Stage moniter of the list

Adds an item to a list

Deletes an itelm from a list

Inserts an item at chosen point of the list

Replaces an item in a list with a new item

Reports what text an item in a list contains

reports how many items a list contains

Checks if a list contains a given string

Show or hide the chosen list on the stage

Figure 7.3. List's stage monitor

Stage monitor

Check box
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ii. Adding Items

Items can be added to a List directly on the stage monitor or by using 
add block .

Figure 7.4 shows the steps to add items on the stage monitor. 

 Figure 7.5 shows the steps to add items using add block . 

Figure 7.5. Adding items using add block 

To make progarm interactive, we can use ask block 
to enter items in the add block   as shown in Figure 7.6.

(a) Blank stage monitor

(b) Script to add items

(c) Added items on stage
monitor

Step 1: Click here to add an 
item.

Step 2: Type name of the list.

Figure 7.4. Adding items on stage monitor
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Figure 7.6. Using ask block 

iii. Deleting Items

Deleting items from the List can be done either directly from the stage 
monitor or by using delete block.

Figure 7.7 shows the steps to delete items directly from the stage monitor.

Figure 7.7. Deleting items from stage monitor  

Figure 7.8 shows to delete items from the List using delete block
.

Delete block has three options (1, last, all) on the dropdown list.

 • 1 deletes the first item from the List.
 • last deletes the last item from the List.
 • all deletes all the items from the List.

To delete items other than 1, last or all, we can type the item number or 
the position number in the delete block.

Figure 7.8. Using delete block

Default optionsType item's position 
to delete the item

Step 1: Select the item to 
be deleted.

Step 1: Click here to 
delete.
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To make the program interactive, we can use ask block to specify the 
item number in delete block as shown in Figure 7.9.

Figure 7.9. Using ask block 

Figure 7.10 shows an example of a program that deletes all items from 
an existing List and adds 10 new items to the List.

Try This on Machine

Create a List called Daylist and add days of a week. Delete Sunday.

Figure 7.10. Deleting and adding items

Deletes all item 
from existing 
list Lists new item
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iv. Inserting Items

New items can be inserted to an existing list at any position. In doing 
so, the existing item at that position will be pushed one level up or 
down in the List. There are two ways of inserting items.

a. Inserting items directly on the stage monitor

To insert a new item above an existing item,

1 select the item,

2 press Shift + Enter, and

3 type the new item.

To insert a new item below an existing item, 

1 select the item,

2 press Enter, and  

3 type the new item.

b. Inserting items using insert block

Figure 7.11 shows how a new item "Rajan" is inserted above the 
item Sangay in the list Namelist.

Running this code inserts Rajan 
at position 4 and pushes Dema to  
position 5, making total number of 
item in the list to 11

Initial list List after running the code

Figure 7.11. Using insert block
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By default, insert block has three default options (1, last, random) 
that can be selected from the dropdown list to position a new item 
as shown in Figure 7.12.

Figure 7.12. Insert options

 • 1 inserts item at the top in the List.
 • last inserts item at the bottom in the List.
 • random inserts item at random position.

iii. Replacing Items

Items in an existing list can be replaced with a new item. When 
replacing an item, the old item will be deleted and its place will be 
taken by the new item. 

Items can be replaced directly from the stage monitor or by using 
replace block.

a. Replacing items directly from the stage monitor

1 click on the item to be replaced,

2 change the item name, and

3 click outside the item.

b. Replacing items using replace block .

Figure 7.13 shows item 3 (Chimmi) is replaced with Tandin in the 
list Namelist.

Default options
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Figure 7.13. Using replace block 

To make the program interactive, we can use say and think blocks 
to display the  items or information on the  List as shown in Figure 
7.14.

iii. Contains Block

This block reports whether an item is in a List. If the item is found, it 
reports true. If not, then it reports false. We can use this block with 
Control blocks to make a decision. Figure 7.15 shows the use of this 
block to check if Pema is present in Namelist.

(b) think block to display the length of
Namelist.

Figure 7.14. Displaying items

(a) say block to display 4th item from
Namelist.
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Figure 7.15. Contains block

Try This on Machine

1. Create a list Days that contains the days of the week.
2. Write a program that reports:

 • whether Tuesday is present in the List;
 • the item at 2nd position; and
 • total number of items in the List.

3. Replace Sunday with the item MyDay.

7.2 Custom Blocks

Custom block is used to create user defined function or procedure. A 
function or a procedure is a set of blocks that performs a specific task. 
Functions are created to break down bigger program to smaller set of 
reusable blocks. Functions make a program simple and enables user to 
correct errors easily.

A. Creating a Custom Block
Figure 7.16 show the steps to create a Custom block.

Reprint 2019
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Figure 7.16. Creating a Custom block.

The Custom block created appears under more blocks category as 
shown in Figure 7.17 .

Figure 7.17. Custom block

B. Editing a Custom Block
Figure 7.18 shows the steps to edit a Custom block

Step1: Click on More Blocks

Step 2: Click on Make Block

Step 3: Type the name of the block

Step 5: Click OK

Step 4: Click on the Option to 
specify the input

Step 1: Right click 
on the block

Step 2: Click Edit 
option Step 3: Choose the 

input option

Step 4: Click OK

Figure 7.18. Edit Custom block 
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C. Calling a Function
A function call instructs specific program block to execute a task. 
Once the program block completes its task, the next script in the main 
program is executed. 

Figure 7.19 shows how to call a function

D. Passing Values to a Function
Values can also be passed to a function. To pass the value, the input 
option must be specified while creating a Custom block as shown in 
Table 7.2. 

Table 7.2 Custom block

Custom block with number input

Custom block without number 
input

(a) Program without
Custom block.

(b) Program with Custom
blocks

(c) Main Program

Calling M
oveForward 

function

Callin
g M

oveB
ack 

functi
on

Figure 7.19. Function and function call 
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Figure 7.20 shows the use of custom blocks to specify the side length of 
a square. The value 100 will instruct the Sprite to draw a square with a 
side length of 100 steps.

Figure 7.20. Passing values 

E. Flowchart to Represent Function
In Class 7, we have learned to draw flow chart for a program.  To 
represent a function in a flow chart, we use the symbol given in Figure 
7.21.

Figure 7.21. Function symbol

Figure 7.22 shows flowcharts and programs that involves the 
use of functions. The main program in Figure 7.22(b) first calls 
MoveForward function and then MoveBack function.

Specify the value

Output
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Try This on Machine

Draw a flow chart and create a program using Custom blocks to 
display the sum and average of five numbers.

Now You Know

1. List stores multiple values under a common name.

2. List blocks are used to modify the items and obtain information
from the List.

(a) MoveForward function (c) MoveBack function(b) Main program

MoveForward

count = 1

wait 1 sec

Point towards left

Change to next costume

Is count > 3 ?

Stop

No

Move 15 steps

count = count + 1

MoveBack

count = 1

wait 1 sec

Point towards right

Change to next costume

Is count > 3 ?

Stop

No

Move 15 steps

count = count + 1

MoveForward

MoveForward 
Function

MoveBack 
Function

Stop

Yes Yes

Figure 7.22. Representing function in a flowchart
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3. We can add, delete, insert and replace items in a List manually on
the stage monitor or by using List blocks.

4. Custom blocks help to create user defined functions or
procedures.

5. A function or a procedure performs a specific task in a program.

6. A function call instructs the specific program to be executed.

7. A function or a procedure can be used for multiple times in a
program.

8. Functions have a specific symbol  in a flow chart.

Check Your Progress

1. Write TRUE or FALSE for the following statements:

a. A List can store multiple values under a single name.

b. We cannot change the items in a List.

c. Contains block checks if the list contains a particular item.

d. Custom blocks are already present in Scratch.

e. We can pass variables to the Custom blocks when we call it.

2. Study the following program given in Figure 7.22 and answer the
questions:

a. Briefly describe what the program does.

b. What are different functions used in the program? Describe
how they work.

c. Draw a flowchart for the program.

d. Try this program in a computer.
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3. Create two lists: one to store names and other to store phone
number of your 5 friends. Write a program that asks for a name
and displays corresponding phone number.

4. Create a list that asks a user to enter 10 different numbers. Write a
program that automatically displays the maximum and minimum
numbers from the list.

5. Create a Custom block that compares two numbers and displays
the larger number.

Figure 7.23.Program

Reprint 2019

ICT Textbook Class 8_2019_CRC.indb   102 7/17/2019   4:52:05 PM



Chapter 7 List and Custom Blocks

103

Explore Further
1. Draw a flowchart and write a program that asks user to enter two

numbers and perform arithmetic operation of user’s choice. Make
the operators appear on the stage monitor as shown in Figure
7.24. Clicking on symbols should call their respective functions
and display the result accordingly.

Figure 7.24. Operators on stage monitor

2. Write a program that draws a bar graph to compare marks of
different subjects. The program should ask for marks of 5 subjects
obtained in the examinations.  Use Variables, List and Custom
blocks in the program. The output of the program may look like
the one in Figure 7.25.

Figure 7.25. List with bar graph
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Web Links

1. List Blocks
 K http://wiki.scratch.mit.edu/wiki/List_Blocks

2. Customs Blocks
 K http://wiki.scratch.mit.edu/wiki/()_(Custom_block)
 K http://wiki.scratch.mit.edu/wiki/How_to_Use_Custom_Blocks
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END OF THE YEAR ACTIVITY
Key Skills
1. Use animations and multimedia elements in presentation.

2. Record and edit sounds using audio editing software.

3. Solve a complex problem by breaking it down into functions.

Task
This year end activity consists of two tasks: creating a presentation 
using animation and multimedia elements, and developing a game 
using Scratch.

1) Designing Presentation

a) Read the contents of your textbook on topics given below.
Select a topic you want to learn more about:
 • computer memory,
 • storage capacity,
 • copyright and Creative Commons, or
 • types of Software Piracy.

b) Browse the Internet for additional information and other
multimedia resources on the topic.

c) Prepare a presentation using relevant multimedia elements.
Refer design principles to make a good presentation.

d) Submit the presentation to your teacher.
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2) Game Development

Develop a game in Scratch using variables, events, functions and
logical operators. The game should contain the following features:

 • appropriate sprites and backdrop for the game,
 • appropriate sounds for the game,
 • player’s score should be recorded and displayed, and
 • player should have specified number of tries or time limit.
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ASSESSMENT CHECKLIST
Name of the student:……………………………………………………………

Roll No:………………….  Class: ………………………   Section: ………….

School: …………………………………………………………………………

Tick (√) under the appropriate column 1, 2 or 3 against each core 
competency statement. The numbers, as described below, indicate the 
competency level of a student in each of the stated skills:

1 = Some of the time  2 = Most of the time  3 = All the time

For Explore Further activity, use tick (√) or cross (X) to show whether 
the student was able to successfully do it or not.

Sl. 
No Chapter 1 Competency / Proficiency

Degree
1 2 3

1 Explain different types of computer memory.
2 Explain storage capacity of computer memory.
3 Differentiate types of storage devices.

Sub Total  I
Explore Further

a Identify and list computer memory units bigger 
than Petabyte.

b List storage devices of early computer era.

Sl. 
No Chapter 2 Competency / Proficiency

Degree
1 2 3

1 Create or modify Slide Master.
2 Add sound and videos to presentation.
3 Animate a presentation.
4 Save presentation to other file formats.

Sub Total II

ICT Textbook Class 8_2019_CRC.indb   107 7/17/2019   4:52:06 PM



Literacy with ICT

108
Reprint 2019

Explore Further
Create a presentation in PechaKucha 20X20 
format and present to the class.

Sl. 
No Chapter 3 Competency / Proficiency

Degree
1 2 3

1 Record audio using simple recording program.
2 Install and uninstall audio editing software.
3 Edit audio files using audio editing software.
4 Share audio files on the Internet.

Sub Total  III
Explore Further

Record, edit and export the song in Audacity

Sl. 
No Chapter 4 Competency / Proficiency

Degree
1 2 3

1 Define malware.
2 Identify different types of malware.
3 Explain types of malware.
4 Apply ways to prevent malware infection.

Sub Total IV
Explore Further

a Identifies ways to protect smartphones from 
malware infection.

b Find out information on Bitcoins and create a 
presentation on it.

Sl. 
No Chapter 5 Competency / Proficiency

Degree
1 2 3

1 Verify online information before using it.

2 Differentiate between copyright and creative 
commons.

3 Explain restrictions used in creative commons 
licenses.
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4 Explain types of software piracy.

5 Describe the consequences of using copyrighted 
materials or pirated software.

Sub Total V
Explore Further

Write a short report on Wikipedia regarding its 
credibility, copyright policy and content alteration.

Sl. 
No Chapter 6 Competency / Proficiency

Degree
1 2 3

1 Use predefined mathematical and string functions 
in a program.

2 Use logical operators to make decision.
Sub Total VI

Explore Further

a Create a game where user wins the game if 3 or 
more out of 5 guesses are correct.

b Create a program to solve a probability problem.

Sl. 
No Chapter 7 Competency / Proficiency

Degree
1 2 3

1 Perform operations on a list with List blocks.

2 Use custom blocks to create functions and 
procedures. 

3 Solve complex problems using functions and 
procedures.

Sub Total VII
Explore Further

a Draw a flowchart and write a program to perform 
an arithmetic operation for a user input numerals. 

b Write a program in scratch to draw a bar graph of 
five subjects. 

Total A = Sub Totals I+II+III+IV+V+VI+VII = …………………
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End of the Year Activity

Sl. No Competency / Proficiency
Degree

1 2 3

1 Use animations and multimedia elements in 
presentation.

2 Record and edit sounds using audio editing 
software.

3 Solve a complex problem by breaking it down into 
functions.

Total B

Total points scored = Total A + Total B = ................................

Score = Number of checklist items 3
Total points obtained

100
#
# ~

Grade = ..........................................

Note: Refer the table on page 112 to award grade.
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ASSESSMENT PLAN
The achievement of learning objectives will be the focus of assessment 
for this course. This will include essential ICT knowledge, skills, values 
and computational thinking practices. This assessment comprises two 
parts: the through-course assessment and the year end assessment, 
which will be examined through observations, conversations and 
portfolios.

The through-course assessment tasks consist of Try This, Try This 
on Machine and Check Your Progress which are designed to gather 
evidences of student proficiency in specific skills defined in the 
learning objectives.

The year end assessment requires students to apply the key skills 
they have acquired over the year in a holistic way. This is a project 
based assessment spanning over several periods. Sample project is 
included in the book but teachers may choose to create their own 
projects, modelled on the sample. Students should also be encouraged 
to come up with their own projects. Teachers should ensure that key 
skills learnt during the course are clearly identified and applied in the 
projects.

In doing the assessment, teachers should focus on observing and 
discussing how: 

» students carry out ICT supported learning.

» students collaborate with peers, and seek support from parents and
teachers.

» students are progressing in their learning on the basis of work they
are doing or have completed.

They should be given ample support and feedback to develop their 
competency in the key skills before they are assessed. This is to ensure 
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that the nature of assessment is mostly formative as envisioned for this 
curriculum.

Assessments are done through checklists based on the learning 
objectives. Student’s competency will graded in a scale of 1 to 3. Grades 
should be given after careful evaluation of how consistently the student 
has demonstrated the required competency. 

The overall competency of a student is determined on the basis of 
the cumulative score of through-course assessments and the year end 
assessment. Based on the student’s score, a grade from A to D will be 
awarded as per the table given below:

Score Grade Description

80 and 
above A

Student is an expert in this area. He/She can 
provide guidance, troubleshoot and answer 
questions related to this area where the skill is 
used.

60 to 79 B

Student can perform the actions associated with 
this skill without assistance. He/She is certainly 
recognized amongst the peers as “a person to ask” 
when difficult questions arise regarding this skill. 
He/She might require help from the teacher once 
in a while.

40 to 59 C

Student is able to successfully complete tasks in 
this competency as requested. He/She will require 
help from the teacher time to time, but he/she can 
usually perform the skill independently.

Less than 
40 D

Student have basic knowledge and understanding 
from experience gained in a classroom. He/She is 
expected to need help when performing this skill.
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Assessing Student Performance
Assessment is an integral part of teaching and learning. Teachers and 
schools are expected to conduct assessment to provide information 
about student’s learning to the learner, the teacher and the parent.

Assessment is of two types: formative assessment and summative 
assessment. Assessment primarily carried out to help students to learn 
is usually called formative assessment or assessment for learning. It 
takes place continually as students are learning. Assessment which is 
primarily for other purposes is often called summative assessment or 
assessment of learning. It usually comes at the end of learning.

The table below shows how assessment is used for variety of audiences 
and purposes.

Assessment OF Learning Assessment FOR Learning

 - To monitor national standards.
 - To report on achievement to 

students themselves and parents.
 - To make teachers, administrators 

and politicians accountable.
 - To screen students for higher 

studies and employment.
 - To determine what courses 

students should take in school or 
university.

 - To help students to learn by 
diagnosing difficulties.

 - To support students to learn 
by providing feedback.

The distinction between summative and formative assessment can be 
confusing. After all, the results of assessment can often be used for 
both the purposes. When the results of assessment are used to evaluate 
student performance, it is called summative assessment. When the 
results of assessment are used to improve student performance, it is 
called formative assessment.
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Assessment requires a variety of data-gathering methods, including 
observations, interviews, performances, and collections of student 
work.
Literacy with ICT looks at assessment through three lenses: 
observation, portfolio, and conversation.

Observations
By observing learners as they engage in using ICT, teachers determine 
which behaviours students have demonstrated and those they are still 
working towards. This information helps teachers plan for instruction 
that will further develop student’s literacy with ICT.

Observation can be either direct or indirect. Direct observation is 
when you watch interactions, processes or behaviour as they occur, 
such as teacher watching student explore the Internet to find specific 
information. The teacher may focus on the student’s ability choose the 
right tool and the relevancy of the information retrieved. 

Indirect observations are when you watch the result of interaction, 
process or behaviour. For example, teacher can inspect the cleanliness 
of the computer lab to determine whether the students are following 
the lab rules. 

Effective observation involves proper planning to determine the focus 
of observation. For example, in order to know how well your student 
applied the strategy while playing logical games, the focus should be 
on looking at the time taken to complete the game.

Teachers could use checklist, recording sheet and field notes to help 
them observe student’s progress in use of ICT. 
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Conversations
Assessing literacy with ICT involves setting learning goals, building 
criteria and giving and getting feedback. These conversations may 
be shared between students, between teacher and student or be self-
reflective. They may also be student-led conferences involving parents. 
This type of conversation is an important part of reporting to you 
about your child’s literacy with ICT.

An effective conversation provides an opinion concerning the 
strengths and weaknesses of the student. The result may be then used 
to plan and design future learning programs. 

Conversation may start with simple question about their plan, quality 
of the work done and the results they achieved.

Portfolios
As they learn, students use portfolios to accumulate evidence of 
their literacy with ICT. These portfolios may be process or product 
portfolios, or a combination of the two. They may be paper-based or 
electronic. The electronic portfolio or e-portfolio may include images, 
audio, PowerPoint slides of the project, animation, video or a simple 
reflection. It can be used by teacher, parents and students themselves 
to document what they are doing (either day-to-day things or through 
their best work or improvements they’ve made).

Involving student actively in the portfolio process develops self-
awareness, goal-setting, and decision-making skills essential for 
lifelong learning. They integrate diverse experiences in their portfolio 
over time and assess their own progress based on evidence and criteria, 
thus fostering the sense of responsibility and ownership of their own 
learning.

Students can organize their portfolios, as blogs, reflections on wiki, 
discussion on forum, and podcasting and vodcasting their works.
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Focus on Proficiency
Assessment in this curriculum is based on holistic assessment of 
ICT skills and knowledge. Component skills will not be isolated nor 
individually assessed. Doing so places strong emphasis on ICT literacy. 
Instead, a checklist would be developed which will define children’s 
levels of performance or proficiency in each of the intended learning 
outcomes. It is hoped this will provide a good overview of children’s 
area of strengths and weaknesses to plan for future learning.
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